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Introduction 
   

Congratulations on the purchase 

of your new F-960 Ripen It! Gas 

Analyzer.  

The F-960 Ripen It! Gas Analyzer 

quickly and accurately measures 

ethylene, CO2, and O2 to assist 

with decision making throughout 

the produce ripening process. All 

three sensors work together to 

give you a clear picture of gas 

concentrations in ripening rooms.  

The Ripen It! features an intuitive user interface, making it 

simple to operate right out of the box. Its lightweight, handheld 

design enables users to rely on the Ripen It! at all stages of 

storage along the supply chain. A built-in data logger stores 

thousands of data points and conveniently transfers data 

through USB or Bluetooth onto a PC or tablet for later analysis. 

With its rapid response time and lightweight handheld profile, 

the F-960 provides a fast, portable verification process for 

atmosphere quality control. The F-960 is ideal for verifying C2 H4, 

CO2 and O2 levels in ripening room applications, laboratories, 

distribution centers, retail centers and storage facilities.  

We hope you enjoy using your F-960 Ripen It! Gas Analyzer. 
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Features & Specifications  
• Measures C2H4, CO2 and O2 

• Displays results in under 30 seconds 

• Past records stored on the device 

• Handheld and lightweight 

• Internal data logging and storage  

• WiFi capable SD card 

• Bluetooth data transfer 

• Battery lasts for 8+ hours 

• Display easily viewed in dimly lit environments 

USES  
 

• Banana ripening quality assurance 

• Optimization of ripening storage atmosphere conditions 

• Bagged and packaged ripening system inspection 

• Storage assignment in distribution centers 

• Ripening room leak inspection 

  



F-960 Instruction Manual rev. 6/23/2017 

 

1554 NE 3rd Ave, Camas, WA 98607, USA                               3 

Phone: (360) 833-8835   
sales@felixinstruments.com  
www.felixinstruments.com 

F-960 Specifications 
Air Sampling Rate 70 mL/min 

Measuring Rate 
Automated, 1 second intervals to SD 
in Continuous Mode 

Data Storage Removable 16 GB SD and Bluetooth 

Display Sunlight visible transflective LCD 

Operating environment 
0°C - 45°C (0-90% relative humidity, 
non-condensing) 

Power Source 
Removable rechargeable lithium-ion 
battery 

Dimensions 18cm x 13.5cm x 5.5cm 

Weight 0.95kg 

Enclosure Powder coated aluminum 

Warm Up Time <3 minutes 

Sensors 
Ethylene (C2H4) 
SENSOR Electrochemical 
Nominal Range 0-1000 ppm 

Full Scale Resolution 1 ppm 

Accuracy Trigger Mode ±5% relative 10 ppm absolute 

Accuracy Continuous 
Mode ±5% relative 2 ppm absolute 

Lower Detection Limit 10 ppm 

Sampling Time 35 seconds 

Zero Interval Weekly 

Recalibration Interval 3 months 

Lifetime 12 months 
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Carbon Dioxide (CO₂) 
SENSOR Infrared sensor, pyroelectric detector 

Nominal Range 0-100% 

Full Scale Resolution  0.01% absolute 

Accuracy – Trigger 
Mode 

±.5% absolute and ±3% of measured 
value 

Accuracy – Continuous 
Mode 

±.01% absolute and ±3% of measured 
value 

Lower Detection Limit 0.01% 

Sampling Time  10 seconds 

Zero Interval Weekly  

Calibration Interval 12 Months 

Lifetime 5 years 

  

Oxygen (O₂) Sensor Electrochemical 

Nominal Range 0-100% 
Full Scale Resolution  0.1% absolute 

Accuracy – Trigger 
Mode 

±0.3% absolute and ±2% of measured 
value 

Accuracy – Continuous 
Mode 

±0.1% absolute and ±2% of measured 
value 

Lower Detection Limit 0.1% 

Sampling Time 10 seconds 

Zero Interval Weekly 

Calibration 6 months 

Lifetime 2 years 
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Unpacking the F-960 Ripen It! 
The F-960 arrives with a hard-sided carrying case, two sets of 

batteries and a charger, a removable SD card, and several 

accessory parts. A sampling port with needle is included for 

taking non-destructive samples from packaging. The sampling 

port is pictured below, connected to the intake. There is also an 

extra Potassium Permanganate Filter (see Maintenance of your 

F-960 Ripen It!: Replacing the Potassium Permanganate Filter) 

and a Closed-Loop Probe used for sampling from Jars (see 

Applications: Sampling with a Jar). 
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Operating Instructions 
WARNING: Do not store the F-960 without batteries! Charged 

batteries must be present in the instrument to maintain the 

accuracy of the sensors, even when the unit is powered off. 

If the batteries of the F-960 discharge during storage, replace 

with charged batteries and allow the instrument to stabilize 48 

hours before use. There is a small internal battery to maintain 

the bias voltage for the ethylene electrochemical sensor. This 

small internal battery will last for 1 day without the main 

batteries before sensor sensitivity is affected by losing its bias 

voltage. The calibration parameter data is intact with or without 

batteries.  

Loading the Battery 
WARNING: Spring-loaded battery cartridge 

The F-960 uses 18650 Li-ion 3.7V 

3100mAh rechargeable batteries. For 

longer lifespan, charge the batteries at 

0.25A. For a faster charge, charge at 

1A. The batteries must be removed 

from the F-960 to be charged. If the 

batteries of the F-960 discharge during 

storage, replace with charged batteries. 

The Li-ion batteries have little self-

discharge and a lifetime of ~ 3 years.   

To remove the batteries, twist the 

battery compartment cap, located on the bottom of the case. 

The cap can be twisted with fingers or a screw-driver to tighten 

or loosen it. Take care when removing batteries, as the cap is 
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spring loaded. Both batteries should be inserted into the unit 

positive (+) side first (towards intake or top). 

Additional button-top 19670 (or protected 18650) batteries can 

be purchased from your preferred battery vendor if 

replacements are needed. 

 

Basic Operation 
To turn the instrument on, press the green power button. The 

current version of firmware is displayed in the lower corner of 

the display screen.  

For information on the latest firmware version, please visit the 

F-960 support webpage: www.felixinstruments.com/support/F-

960 

The battery meter is listed on the lower right hand side of the 

display. 

The main menu displays the following options: Measure, Setup, 

and File. If the power button is pressed, the display will prompt 

for confirmation before shutting down the F-960.  

To scroll between menu 

items in the list, use the Up 

and Down arrows. To select 

an option from the menu list 

use the Right arrow. To exit, 

use the Left arrow.  

Measurement Modes 
Two measurement modes are incorporated into the F-960 Ripen 

It! 

Felix Instruments 

Measure  
Setup 
File 
F-960 Vx.x.x.x 

http://www.felixinstruments.com/support/F-920
http://www.felixinstruments.com/support/F-920
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 Continuous mode 

 Trigger Mode 

Continuous mode measures the air entering through the input 

of the instrument continuously without stopping. Continuous 

mode can be used with or without the sample port attached to 

the front of the instrument. Data is saved to a file every one 

second on the F-960. 

Trigger mode measures the air entering through the input of 

the instrument, the pump will run and the sample will enter 

until a stable reading has been achieved. The final values will be 

displayed on screen and saved to the SD card. The pump will 

then turn off until the user initiates a new measurement. 

Trigger mode can be used with or without the sample port 

attached to the front of the instrument. See the specifications 

page for standard sample rate. 

To change between modes, Navigate to Setup > Mode from the 

main menu.  

Measure 
From the main menu, press the right arrow when the word 

‘Measure’ is highlighted to enter the measurement display 

screen. All measurement parameters are saved to the SD card 

every 1 second in continuous mode. When the SD card is not 

present, the data will not be saved. The unit also comes 

equipped with Bluetooth technology, designed for wireless 

transfer of data (see Transferring Files) as well as a Wireless SD 

memory card (see Wireless SD Memory Card Operation). 
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If sampling very high concentrations followed by very low 

concentrations, allow the instrument to purge internal gas for 

the most accurate measurements.   

Continuous Mode 
When in continuous mode, a graph of the concentration of each 

gas can be viewed over time. The default graph shown is the 

C2H4 concentration in ppm. To view the O2 or CO2 graph, simply 

use the up and down arrows to scroll through the graphs. The 

current gas being graphed is shown on the top of the screen 

with the concentration in large font as shown below.  

 

The x-axis of the graph represents time elapsed. The y-axis of 

the graph displays the range of the concentration in % for CO2 

and O2, and the dynamic range is labeled at the top. The y-axis 

scale is set by the highest value shown in the active display.  

The graph begins on the Left side and moves toward the right as 

more data accumulates. The total measurement time is 

displayed below the graph. The flowrate (mL/m) is displayed at 

the bottom.  
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Trigger Mode 
A measurement in trigger mode will initiate a small volume 

sample taken over several seconds until the reading is stable. To 

begin, press the square start button as prompted to measure. 

This will turn on the pump before drawing in sample gas. After 

the measurement is complete, purging will flash in the bottom 

left hand corner of the display. Trigger mode will take longer to 

stabilize if the concentration is in a different range from the last 

sample.  

 

 

The results will be saved to the SD card. Press the square start 

button to begin another measurement. Press the Left arrow to 

exit to the main menu.  

Taking a Measurement 
Assemble the probe and connect the needle probe tubing to the 
intake of the F-960. Twist on a hydrophobic filter to the end of 
the tubing. The filter will inhibit any moisture or debris from 
entering the instrument. [NOTE: Failure to use a hydrophobic 
filter risks drawing liquids into the instrument, which can 
potentially damage the instrument sensors.] Finally, attach a 
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sterile needle to the filter. Depending on the application, 
needles can be re-used.   

 

 

From the main screen, select ‘Measure’ and then the right 

arrow button. This will initiate a measurement in either mode. 

The F-960 will run either continuously (continuous mode) or 

until the minimum stable sample volume has been reached 

(trigger mode). Press the Left arrow button to return to the 

measurement screen.  

Passcode Protection 
Certain menu systems on the F-960 are protected by a passcode 

setting. These menu systems include Parameters, Set Zero, 

Calibration, and Factory Setup. The default code for entry is 

‘1111’. The passcode only needs to be entered once for each 

reboot of the device. If the device is powered off, the passcode 

will need to be entered again for entry into the menu systems 

described above.  

To set the passcode to a four-digit code other than the default 

setting, please follow the steps below. 

1. Open SD card on PC 

2. Click the ‘View’ tab in the taskbar 

3. Click ‘Options’ in the far right of the toolbar 

4. Open the ‘View’ tab 
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5. Scroll down and uncheck the box named ‘Hide 

protected operating systems (Recommended)’ 

6. Check the box named ‘Show hidden files, folders, and 

drives’ 

7. Click ‘Yes’ 

8. Click ‘Apply’ and then click ‘OK’ 

9. Open the Config.txt file that should now appear inside 

the SD card 

10. Alter the ‘1111’ to four-digit numeric passcode desired 

11. Save the changes 

12. Insert SD card back into Gas Analyzer 

Setup Menu 
Use the right arrow to enter the Setup Menu from the Main 

Menu screen. The following options are available: 

Mode 
Set Zero 
Calibration 
O2 Calibration in Air 
Date & Time 
RH Conversion 
GPS 
Language 
Factory Setup 

Setup > Mode 
The Mode menu contains two options: 

Measure: switches between Continuous and Trigger mode.  

Connection: switches between USB Storage (default), Bluetooth 

(enabled in future versions), or USB Ctrl (enables 
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communication to software or transfers data only if using a 4 

GB SD card).  

To change, use the Up/Down arrows to cycle through the mode 

options. Press the Left arrow to exit to the main menu. 

 

Setup > Set Zero 
The set zero process sets a new baseline, or zero, for the 

sensors: 

C2H4 

CO2 

O2 

Set zero should take place weekly for the Ethylene (C2H4), 

Oxygen (O2) sensors and Carbon Dioxide (CO2) sensors to 

maintain maximum performance. To set zero, first press the 

right arrow to select the sensor. The set zero process requires 

100% nitrogen gas to set zero for O2, an internal Potassium 

Permanganate jar to set zero for C2H4, and an option to use an 

external conditioning chamber full of Soda Lime or nitrogen gas 

to set zero for CO2. Wait for a beep to verify the set zero 

process was completed. Setting zero is important in establishing 

a zero baseline for the sensors.  

Mode 

Measure             Trigger 

Connection  USB Storage 
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For the O2 sensor, an alternative calibration, O2 calibration in 

air, can be used instead of setting zero with 100% N2 gas. Please 

see the ‘O2 Calibration in Air’ section for more details on this 

process.  

The following instructions can be followed to set zero for the 

CO2 sensor: 

The F-960 is shipped with an external conditioning tube and a 

jar of Soda Lime. Fill the conditioning tube with the Soda Lime 

granules, keeping the ends packed with the cotton ball filters. 

Connect the external conditioning tube to the inlet and outlet of 

the F-960, seen below. Continue through the standard set zero 

process. The F-960 will prompt the user to use “0ppm/N2”. The 

Soda Lime external conditioning tube creates a 0 ppm CO2 

environment, alternatively, the user can connect N2 gas, which 

provides a 0 ppm CO2 environment as well. 

*The Soda Lime external conditioning tube is used for the CO2 

Set Zero process only. 
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Next, verify the set zero calibration by measuring ambient air. 
Run the set zero calibration again if the verification is not 
successful. 
Note about setting zero for the ethylene (C2H4) sensors: 

Although there is an internal chamber of KMnO4 that is used to 

set zero for the ethylene sensor, it may be advisable to 

additionally use an external conditioning chamber full of 

KMnO4, creating a closed loop system as described above with 

the Soda Lime. This is particularly advised when in an 

environment exposed to cross-sensitive gasses, such as 

alcohols.  

Setup > Calibration 
The calibration feature allows the user to set zero and set span 

without the use of a computer or G.A.S. (Gas Analysis Software). 

Unlike Setup > Set Zero, a zero standard gas is required as well 

as standard gases for the set span process. 

The F-960 Ripen It! Will prompt the user to set up a zero gas, 

which can be achieved by feeding 100% Nitrogen (N2) gas to the 

intake. The unit will countdown to set zero. The following 

screen will prompt the user to setup a span gas, which is a 

known standard gas used for the span calibration process. For 

more information on standard gases used for calibrating the 

Ripen It! Refer to the calibration section in the ‘Maintenance of 

your F-960 Ripen It!’ section. 

Setup > O2 Calibration in Air 
Alternative to setting zero for the oxygen sensor weekly with 

100% N2 gas, a user can use the O2 calibration in air menu 

option to calibrate the O2 sensor using ambient air.  
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Right arrow on this menu option to begin the calibration. The 
display will read, ‘Use fresh air (20.9%) Please wait…’. The F-960 
will beep upon completion of the O2 calibration in air. 

Setup > Date and Time 
To adjust the date and time, use the Right and Left arrows to 

move between Month/Day/Year and Hour/Minute/Second and 

use the Up and Down arrows to change the values. To exit, use 

the Left arrow to back out of the screen and return to the Setup 

menu.  

 

 

 

 

 

Setup > RH Conversion 
The Setup RH Conversion menu is used to correct for the 

temperature sensor being inside F-960 housing. This causes the 

temperature sensor to reflect the temperature of the F-960 and 

not the ambient temperature, which is usually several degrees 

above ambient. The Relative Humidity is calculated based on 

the temperature value.  

Date & Time 

MM/DD/YYYY      hh : mm : ss 

04/21/2016  17 : 01 : 43 
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Enter the correct ambient temperature in degrees Celsius, 

measured from an external 

temperature sensor. To use 

the entered temperature for 

RH calculations, “use sample 

T” should be set to “Yes.”  

The current (internal RH) and 

corrected (sample RH) are 

displayed at the bottom of 

the screen.  

 

Setup > GPS 
The GPS sensor inside of the F-960 Ripen It! can be used to 

record latitude and longitude +/- 10 meters. The instrument 

should be operated outside, without overhead obstruction for 

best GPS performance. The Setup > GPS menu turns on/off the 

GPS sensor and displays the current GPS data.  Data is also 

saved to the SD card as a .csv file. 

 

Setup > Language 
The Language menu will display options for: 

RH Conversion 
Enter Sample T(C)       20.0 
Use Sample T                 Yes 
(for measurements) 
 
Internal RH (%)             43.6 
Sample RH (%)              21.3 

GPS 

Enable GPS  Yes/No 

Acquiring GPS data….. 

Longitude                             122.558 

Latitude                                    45.59 
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English 

Spanish 

Portuguese 

Use the Up and Down arrows to select. 

Setup > Factory Setup 
The Factory Setup menu is used to: 

Restore: Restores factory defaults 

Backup:  Backs up current parameters. “Backup device’s 

                 configurations?”: NO or YES 

File Menu 
In the File Menu, the user can manipulate files on the F-960 

Ripen It! The F-960 will by default save to the most recently 

used file on the instrument. The file menu contains: 

Select 

Create 

Delete 

Review 

All files created by the F-960 are .csv (comma separated value) 

file extensions.  

To view data on a computer, simply insert the SD card into a 

computer’s SD card reader (always power off the F-960 before 

removing the SD card). The computer should automatically 

detect the SD card as a new storage device enabling access to 

measurement data from any computer. (The mini-USB port can 

also be used to establish a USB connection with a computer to 

transfer data from the F-960 Ripen It! only if using the 4 GB SD 

card). 
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File > Select 
File Select displays a list of .csv files that exist on the F-960 

Ripen It! SD card. Use the Up/Down arrows to move between 

files, and right arrow to select a file to which new data will be 

saved. If the unit is powered on and no file is selected, the data 

will be default saved to the file data.csv. In the file, each data 

point is labeled with time and date for easy sorting.  

 

File > Create 
Pressing the Right arrow when ‘Create’ is selected will create a 

new file according to the naming scheme programmed on the 

instrument, XX_XX_XX_X or Year_Month_Date_Ordinal. After 

pressing the right arrow, go to File > Select to see the list of files 

on the SD card. There will be a new file in the list with the 

current date.  

 

File > Delete 
File Delete displays a list of files that exist on the F-960 Ripen It! 

SD card. Use the Up/Down arrows to scroll between files and 

use the right arrow to delete the selected file. A message will 

Select 

Data . csv 

16_04_04_0 . csv 
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appear: “Delete File?” Press the Left arrow for No, leaving the 

file intact. Press the Right arrow for Yes, deleting the file.  

 

File > Review 
File Review displays a list of files on the SD card and allows you 

to view the data contained in the files. Use the Up/Down arrows 

to scroll between files and the right arrow to enter the selected 

file. When reviewing trigger mode files, the software can 

support viewing up to 10 records at a time. The data.csv file is 

the F-960 default file used to store data when no other file is 

selected.  

After selecting a file name, the measurement mode with time of 

the measurement and gas concentration will appear for Trigger 

mode readings. Use the Up and Down arrows to highlight a 

measurement and the Right arrow to enter the measurement 

and see more detailed data, including Date, Time, O2 and CO2 

concentrations, Mode, and Sample Volume.  

Transferring Files 
Open the saved data files on the SD card using Microsoft Excel 

or Notepad. Data files are saved as .csv file extensions (comma 

separated values). The following figure is an example data 

spreadsheet. Data values included are the date and time of the 

measurement, the measurement mode, the CO2 concentration 

Delete 

Data . csv 

16_04_04_0 . csv 
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in percent, the O2 concentration in percent, the temperature of 

the gas stream in degrees Celsius, the relative humidity (RH) of 

the gas stream in percent, the flow rate of the gas stream in 

milliliters (mL) per minute, and GPS data. 

 

  

 

Example spreadsheet data from an F-960 Ripen It!  

 

 

REMEMBER: Always save the data files to the computer before 

making changes or starting analysis. *Raw output field 

SD CARD 
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designations: Raw C2H4, Raw O2, Raw CO2, CO2 Ref, Zero 

Baseline, Temp (10x), RH (10x), Battery Voltage, Pressure (mbar) 
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Wireless SD Memory Card Operation 
These instructions are meant to accompany the instructions 

supplied by the vendor for Toshiba FlashAir™ W-03 to use 

specifically with the F-960 Ripen It! Gas Analyzer, which can be 

similarly applied to other Felix Instruments products. 

1. Install FlashAir™ Wi-Fi card software appropriate to the 

SD card. 

a. Visit https://www.toshiba.co.jp/p-

media/english/download/wl/software02.htm to 

download the software for configuring the Wi-Fi 

card and obtain vendor operation instructions. 

2. Insert the Wi-Fi card onto a personal computer (PC). 

3. Open the “FlashAirTool” on your PC to configure the SD 

card. 

4. Follow the configuration instructions prompted by the 

“FlashAirTool”. 

5. For additional guidelines, access the “Help” menu inside 

the “FlashAirTool” software. 

 

https://www.toshiba.co.jp/p-media/english/download/wl/software02.htm
https://www.toshiba.co.jp/p-media/english/download/wl/software02.htm
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6. The Wi-Fi card can be enabled in “internet pass thru 

mode”, outlined in the following documentation 

provided within the FlashAirTool software: 

• Go to Network Settings on the main menu 

Check Internet pass thru mode 

This function is available for FlashAir™ W-03 

and FlashAir™ W-02 (Ver. F19BAW3AW2.00.02 

or later) cards. 

 

When this function is enabled, the FlashAir™ 

card can be used like a router, by allowing 

another access point to be connected via the 

card. 

When an internet access point is connected, 

images stored on the FlashAir™ card can be 

viewed, and the internet can also be accessed. 

This is convenient when, for example, uploading 

image files downloaded form a FlashAir™ card 

onto social networking services, as there is no 

need to change the Wi-fi device network 

settings on your smartphone. 

 

 

* CAUTION: If you want to connect to the 

internet without using the internet pass thru 

mode, the wireless LAN setting connection on 
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your smartphone or other device must be 

changed from the FlashAir™ card to the internet 

access point. 

Check the “Enable internet pass thru mode” 

checkbox to enable “internet pass thru mode”.  

o Access Point SSID 

Sets the SSID of the internet access 

point. 

Enter the SSID for the access point that 

you will use. An SSID of up to 32 

alphanumeric characters can be 

entered. 

o Access Point Password 

Set the internet access point password. 

Enter the password for the access point 

that you will use. 

o In your browser, enter http://flashair to 

view or stream your files 

 

For more information on the Toshiba FlashAir™ W-03 Wireless 

SD Memory Card, contact the application vendor at 

https://www.toshiba.co.jp/p-media/wwsite/contact.htm, 

 

 

http://flashair/
https://www.toshiba.co.jp/p-media/wwsite/contact.htm
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F-960 Ripen It! Menu Map 
Below is a map of the F-960 Ripen It! Two Gas Analyzer menu 

system. Press the right arrow to enter a menu and the Left 

arrow to exit.  
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G.A.S. Gas Analysis Software 
G.A.S. software enables the user to not only calibrate the F-960 

Ripen It!, but also view graph displays of measurements, 

download, edit and add notes to files, create upper and lower 

thresholds for quality monitoring, and remotely navigate 

through the F-960 Ripen It! menu system. 

A. Download the F-9x GAS_LAB_setup.exe from 
https://felixinstruments.com/support/F-960/software/ 

B. Install 
C. Launch the downloaded G.A.S. program 

  
There are two ways to connect the F-960 Ripen It! To the G.A.S. 
program: Bluetooth or USB cable connection.  
 

 
 

1. For USB cable connection, move ahead to step 4. For 
Bluetooth connection, on your F-960 Ripen It!, navigate to 
Setup > Mode > Connection > Bluetooth. On your 
windows pc navigate to Settings > Devices > Bluetooth 
and pair your computer to the F-960 Ripen It!  
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2. Verify that the passcode matches between the F-960 

Ripen It! and the computer, accept each. 

 

3. Once verified, navigate back to G.A.S., the program will 
initiate a connection with the F-960 Ripen It! 
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4. Once connected, your device serial number should appear 

in the upper left hand corner of the window, click on the 
serial number, you are now ready to interact with the F-
960 Ripen It! Click on the grey and blue square in the 
upper right hand corner to dis-connect or re-connect. 
 

 

 
Menu System 
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The following will describe the menu system functions and 
symbols: 
 

  
The ‘Files’ menu allows viewing of all files saved to the F-
960 Ripen It! 
 
 
The ‘Measurement Monitor’ menu displays 
measurements graphically in real time.  

 
  The ‘Control Panel’ menu displays toggle keys which 

allow the user remote control of the F-960 Ripen It! 

 

 The ‘Calibration’ menu navigates the user through the 

calibration process for both set zero and set span. 

 

Files   

The files menu will display all files saved to the SD card of the F-

960 Ripen It! 
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Just select the file of interest and choose whether to download 
the file from the device, 

 
 
Or open a saved file from your pc. 

 
  
When the document appears on the right-hand column, select it 
to view and make edits in the 'Note' section. Edits can include 
deleting the file and making customized notations. 
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Once done reviewing and editing your data, select the save icon 
to save your changes. These changes will be saved to your pc. 

 
 
 
Measurement Monitor   
 
The Measurement Monitor menu allows the user to view a 
graphical live feed of measurements taken on the F-960 Ripen 
It! This feature will display the measurement mode being used, 
the selected gas, temperature, flow, and RH with the option to 
toggle between CO2, O2 and C2H4. Zoom-in and zoom-out 
display can be adjusted as well as the time interval. Left click on 
the line to see information on the data point! 
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When Trigger mode is selected, the measurements will display 
upon completion in consecutive rows where the user can again 
edit and add notes to the data. 
 

 
 
Control Panel   
 
The Control Panel Menu allows the user to control the F-960 
Ripen It! From a computer using a series of toggle keys seen 
below. 
 

 
By pressing up or down, the user can navigate through the file 
menu to change settings on the unit and use the square button 
to take a measurement. 
 
Calibration 
   
The Calibration menu enables a two-point calibration process 
for the F-960 Ripen It! Including Zero Calibration and Span 
Calibration. The set zero process will require known standard 
gas of 100% Nitrogen (N2) gas to set a zero baseline. Next the 
user will be prompted to connect a known standard gas to set 
the span for your sensors. We suggest the following: 
 
C2H4 Set Span: 5 ppm C2H4 standard gas 
CO2 Set Span: 95% CO2 standard gas 
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O2 Set Span: 50% O2 standard gas 
Each sensor will require its own standard gas for calibration. 
After the set span is complete it is best practice to verify your 
calibrations were successful by reading the standard gas to 
ensure accuracy. 
  

 
  
  
  
Settings 
 
G.A.S. offers a settings menu allowing the user to switch 
between continuous and trigger modes, as well as setting 
thresholds for QA monitoring. 
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The user has the flexibility to create a customized validation 
profile, creating unique profile names and threshold values for 
each gas of interest, useful for quality monitoring! 
  

 
  
Simply "apply validation profile" created after selecting your 
customized validation profile, and then proceed to see your 
results in the Measurement Monitor display. 
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Firmware Update 
To update the firmware on the F-960 Ripen It!, you will need to 

download and install G.A.S. as outlined in the previous section. 

Launch the software, connect your device and select “Help”. 

 

 

This will reveal a menu with the option to update your 

firmware. 
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Once “Upgrade Device Firmware” is selected, the software will 

outline a series of steps for the upgrade. 

 

Follow the instructions provided in steps 1 and 2, step 3 

requires the selection of a .dfu file, which can be downloaded 

from: https://felixinstruments.com/support/F-960/software/ 

Once the file is downloaded to your computer and selected in 

step 3, click install as prompted in step 4. 

You will be prompted to wait while the firmware upgrades. 

 

Followed by a confirmation that the firmware uploaded 

successfully. Press “OK” and proceed to power on the unit by 

https://felixinstruments.com/support/F-920/software/
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pressing and holding the power button for 10 seconds. You’re 

done! 

 

Maintenance of your F-960 Ripen It! Gas 

Analyzer 
 

Long Term Storage of the F-960 
WARNING: If you plan to store this device for longer than 

one month, follow the instructions below on how to 

disconnect the O2  and C2H4 sensors from the board. This 

will prolong the life of the O2 and C2H4 sensors. 

1. Turn off the F-960 Ripen It! And remove the 
bottom rubber mat.  

2. Remove the battery cap (it’s spring loaded!) and 
unscrew the black bottom plate of the F-960. 



F-960 Instruction Manual rev. 6/23/2017 

 

1554 NE 3rd Ave, Camas, WA 98607, USA                               39 

Phone: (360) 833-8835   
sales@felixinstruments.com  
www.felixinstruments.com 

 
3. Unplug the connector for the ethylene sensor by 

gently pulling it out. 

 
4. Unplug the red and black cable connector by gently 

pulling the fastener out the end of the O₂ sensor. 
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5. After reconnecting the sensors, insert fully charged 

batteries and allow 24 hours to stabilize the 
sensors.  

 
 

Replacing the Oxygen (O₂) Sensor 
The oxygen sensor has a life span of one (1) year, and the 
replacement of the sensor is simple and quick. To purchase the 
sensor from Felix Instruments contact 
sales@felixinstruments.com. To replace the sensor refer to 
images on following page: 
 

6. Turn off the F-960 Ripen It! and remove the bottom 
rubber mat.  

7. Remove the battery cap (it’s spring loaded!) and 
unscrew the black bottom plate of the F-960.  

8. Unplug the red and black cable connector by gently 
pulling the fastener out the end of the O₂ sensor. 

9. Unscrew the O2 sensor (counter-clockwise). 
10. Screw in the new sensor (clockwise) until you feel a 

resistance—not too tight! 

mailto:sales@felixinstruments.com
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11. Plug in the cable connector by pressing the white 
fastener into the end of the new O2 sensor. 

12. Screw the bottom plate into position, and fasten the 
battery cap. 

13. Place the bottom rubber mat—and congratulations 
you’ve done it! 

14. Photos of the process are below. 
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Replacing the Potassium Permanganate Filter 

(KMnO4) 
The Potassium Permanganate will expire after prolonged use 

and is easy to replace. The small black jar is the KMnO4 filter, 

just unscrew the bottom plate of the F-960 unit after removing 

the battery cap, unscrew the filter, screw in the replacement 

and you’re done! Screw back into place the bottom plate and 

finally the battery cap. 
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Calibration 
Full set span calibrations should take place every three months 

for the C2H4 sensor, annually for the CO2 sensor, and bi-

annually for the O2 sensor. Always set zero before setting span. 

For C2H4 calibration standard gases, we suggest 5 ppm C2H4 

and a verification gas of 2 ppm, for CO2 calibration standard 

gases, we suggest 95% CO2 for the set span procedure and a 

verification gas at a lower value, like 16%. For O2 Calibration 

standard gases, we suggest 50% O2 for the set span procedure 

and a verification using ambient air (20.9% O2). 

The F-960 allows the user flexibility with calibration, there are 
two methods for calibrating: utilizing the computer-free 
calibration method through on-device adjustments under Setup 
> Calibration on the F-960, OR by using the computer software 
program: G.A.S. (Gas Analysis Software). 
 
The G.A.S. Calibration menu enables a two-point calibration 
process for the F-960 Ripen It! Including Zero Calibration and 
Span Calibration. 
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Set zero should take place weekly for all sensors to maintain 
maximum performance. The set zero process does not require 
G.A.S. and can be done following the processes outlined in the 
“Setup > Set Zero” section of the user manual. Set zero 
optionally CAN be done with G.A.S. utilizing 100% N2 gas (which 
represents a 0% CO2, C2H4 and O2 environment).  
  
After setting zero, select "Span Calibration" and follow the 
instructions outlined in the software to complete the Span 
calibration process, a diagram outlining how to connect your 
standard gas will display.  

 
The timer is defaulted to 3 minutes which is typically a sufficient 
stabilization period, if a longer stabilization period is needed 
increase the timer to 5 minutes. Press start and wait for the 
calibration process to complete.  
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After pressing "Start", you will see the following prompt 
reminding the user of the set Zero process. 
  

 
  
If you have already completed the set zero process, press "Ok". 
Another prompt will appear asking the user to put the device in 
Continuous Monitor mode (On the F-960 Ripen It!: Setup > 
Mode > Measure > Continuous). Then navigate to the main 
menu and begin measuring. 
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Press "Ok". The G.A.S. software will begin the calibration 
process and count down. 
 

 

Once the calibration is completed, a green verification can be 
seen above the start button. 

 
Following step 6 of the instructions listed, you should now verify 
the calibration was successful by taking a reading of the 
standard gas used in the process. The reading should fall within 
specifications outlined in the beginning of this manual. 
 
Continuous Mode Verification *After Set Span 

The following procedure is to check whether the sensors were 
calibrated to read within spec of the actual gas value. For C2H4, 
O2 and C2H4, refer to the specifications page.  

 
It is highly recommended that this step be performed after 
one full day has passed since the calibration was performed. If 
this step is not performed, accuracy of the calibration cannot 
be verified. 
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Connect and read each gas and record the results here after 
three minutes (at least) of measure time. If any of the values are 
out of specification, check your procedure and recalibrate the 
sensor again. 

Gas Concentration Pass/Fail 

Air (Air is ~20.9% O2) 20.9% O2 □Yes      □No 

CO2 Verification Gas 
 

□Yes      □No 
O2 Verification Gas Can use Air □Yes      □No 

C2H4 Verification Gas 
 

□Yes      □No 

 
For information on sourcing known gases required for 
calibration, please refer to the following website to inquire 
about your region: 

https://www.airliquide.com/group/where-we-operate 
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Applications 

Sampling with a Jar 
The F-960 comes with an extra accessory sample probe for 
creating a closed-loop system for sampling enclosed headspace 
in a sealed container. The example below displays a glass jar 
with a built-in septum for easy insertion of each sample probe. 
The standard sample probe is connected to the intake/inlet of 
the F-960 while the closed-loop sample probe is connected to 
the outlet. By creating a closed loop, the rigid jar will not 
pressurize by the displaced sample gas removed from the jar. 
The gas will be drawn into the F-960, analyzed by the sensor, 
and then re-circulated back into the jar through the closed-loop 
sample probe. For larger jars/containers, CO2 gas may settle to 
the bottom. This can be compensated by adding a small 
circulation fan inside the jar or by lying the jar on its side closer 
to the sample syringe.  
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PolarCept 
It is recommended to use the external PolarCept filter when 
measuring a mixture of gas 
(such as when sampling fruit) 
or interfering gases may be 
reported by the instrument. 
The PolarCept filter is 
recommended for Trigger 
Mode. PolarCept should only 
be used with 1.5 mL of 
distilled or deionized water.  
The PolarCept filter consists 

of a plastic molded housing, 

hydrophobic filter and O-ring. It is attached to the sample probe 

in place of the hydrophobic filter and utilizes the same sample 

probe needle at the end. A small plastic syringe is used to fill 

and empty the PolarCept filter. Once the hydrophobic filter and 

O-ring are in place it should be very difficult to remove it and 

create a leak-proof seal. Additional hydrophobic filters are 

included as replacements, when the filter is soaked with water 

or damaged during removal, replace the filter.   

After measuring, the water in the PolarCept filter will become 

saturated with trapped interfering gases and should be replaced 

with fresh distilled water. Saturation rates will depend on the 

amount of interfering gases present in the sample environment. 

The table below shows example saturation times when 

measuring headspace of bananas (with a maturity index of 5) in 

Continuous Mode. This sample contains various mixed 

hydrocarbons, ethylene and VOCs.   
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VOC concentration PolarCept saturation (min) 

3 ppm 20 

100 ppm 1 

 
To fill the PolarCept filter, attach an empty syringe to the 

hydrophobic filter. The plunger of the syringe should be 

completely depressed. Lower the PolarCept over a cup of 

distilled water and draw in 1.5 mL with the syringe. Attach the 

sample needle and tubing. To empty the PolarCept, re-attach 

the syringe and push the water out of the PolarCept housing.   

To properly use 

PolarCept, keep the 

sample needle 

pointed down while 

measuring. The water 

in the filter should 

“bubble” as the gas 

sample is pulled 

through, trapping interfering gases.   
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F-960 Production Test Check Sheet 

SERIAL NUMBER:  

Firmware Version:  

 

 

 

 

 

 

NOTES:                                                                                                       
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Guide for Purchasing Standardized Gases 

for Calibration 
When deciding which standard gases to purchase for 

calibration, there are some important considerations that will 

help guide your purchase: 

1) Determination of concentration of the gas to be 

purchased. The concentration of the standard gas is 

the first consideration. It needs to be at a 

concentration level that is appropriate for 

calibration of the instrument.  

 

2) Determination of proper regulator for the standard 

gas tank. A regulator is needed to provide a 

consistent flow of gas to the instrument at a certain 

rate. At our facility, we use on-demand regulators 

that require the pumps within our instruments to 

pull the gas from the standardized tank. If this is not 

an option, other regulators are acceptable, just use 

a T-junction when connecting to the instrument to 

protect the instrument from damage.  

 

3) Determination of the size of tank to order. Consider 

how many calibrations can be performed with the 

volume of gas purchased. Each calibration for the F-

920, 940, and 960 will take around 0.3 liters of 

standard gas.  

Below is an example of a standard order our company would 

make to Air Liquide for a 1.5ppm ethylene standardized gas 

tank for calibration of the F-940. 
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Air Liquide is a multi-national company that can deliver 

products to most business locations worldwide.  You may look 

at www.airliquide.com for your local office. 

Air Liquide America Specialty Gasses LLC  

Telephone 425-931-8303 or 800-814-4642 

A sample order for 34 Liter canister of appropriate calibration 

gas for an F-940 or F-960 would include the following (Note, 

these are Air Liquide’s 

unique product numbers): 

Part Number:

 A0909352

 Scotty 34 

Description: 2 

Component Mix, 

Balance Air, Gas 

34, NR 

 

 AIR 

 BAL 

 

 ETHYLENE 1.5 PPM 

Phase: Cylinder Gas Measurement: Mole Class: 

N/A 

Size: 34  

Your gas vendor will do their best to meet your specified 

concentration and will provide a certificate of analysis with your 

http://www.airliquide.com/
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gas showing what they have delivered. Be certain to use the 

actual value on the certificate of analysis as it may differ from 

what you have ordered. 

If you don’t already own a regulator, you must buy one. The 

following is the ordering information  for the on-demand style 

regulator that we typically use. (Note, these are Air Liquide’s 

unique product numbers) 

Part Number: A0315576 

Description: Q114DRFRC10 – M14 Demand 

Regulator 

0 – 3 LPM @ 3’ 
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Warranty Information 
 

Seller's Warranty and Liability: 
  
Felix Instruments- Applied Food Science warrants new 
equipment of its own manufacturing against defective 
workmanship and materials for a period of one year from 
date of sale. The results of ordinary wear and tear, neglect, 
misuse, accident and excessive deterioration due to 
corrosion from any cause is not to be considered a defect.  
Felix Instruments’ liability for repairing or replacing 
defective parts during the warranty period is contingent 
on examination by a Felix Instruments authorized 
representative. Felix Instruments liability will not extend 
beyond repairing or replacing parts from the factory where 
they were originally manufactured. Repair or alteration by 
an unauthorized technician voids warranty.  
Material and equipment which is not manufactured by 
Felix Instruments is to be covered only by the warranty of 
its manufacturer. Felix Instruments will not be liable to the 
Buyer for loss, damage, or injury to persons or to property 
by the use of equipment manufactured by other 
companies.  
 
 
Buyer accepts the terms of warranty through use of this 
instrument and any accessory equipment. There are no 
understandings, representations, or warranties of any 
kind, express, implied, statutory, or otherwise (including, 
but without limitation, the implied warranties of 
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merchantability and fitness for a particular purpose), not 
expressly set forth herein. 
 
All instrument repairs or replacement covered under 
warranty require a Returned Material Authorization (RMA) 
number. Please contact Felix Instruments technical 
support department at support@felixinstruments.com to 
obtain an RMA number before shipping instrument to CID 
Bio-Science, Inc.  
 
Buyer is responsible for shipping charges to Felix 
Instruments headquarters: 
 
1554 NE 3rd Ave. 
Camas, WA 98607 
USA 
 
 
Felix Instruments is responsible for return shipping charges 

on repairs and/or replacement covered by warranty. 

 

 

 
Warranty Registration Card 
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1554 NE 3rd Ave, Camas, WA 98607, USA 
Phone: (360) 833-8835  Fax: (360) 833-1914  e-mail: sales@felixinstruments.com Web: www.felixinstruments.com 
  

PRODUCT REGISTRATION CARD 

Please complete and return this form to Felix Instruments within 30 days to validate your Warranty on Parts & Labor. 
    
Registration Information: 
  

Your Name:____________________________________ Title:__________________ 

Company/University:___________________________________________________ 

Address:_____________________________________________________________  

City:____________________________ State:__________ Zip:__________________ 

Country:__________________________Email_______________________________ 

Phone:______________________________ Fax:____________________________ 

Felix Instruments Serial Number(s):__________________________________________________  

Purchase Date:_____________________Purchase Price:_____________________  

------------------------------------------------------------------------------------------------------------------ 
FOLD ON DOTTED LINE 

   
  
Your opinions will help improve our service. Please answer the following questions. 
 
1. What was the basis of your product selection? 
□ Representative Recommendation    □ Price 
□ Product Features     □ Product Design 
□ Technical Specifications     □ Brand Name 
□ Warranty       □ Service 
□ Other _________________________________________ 
 
2.  What other competing brands did you consider? __________________________ 
 
3. Where did you first learn of this product? 
□ Advertisement in ________________________________   □ Representative 
□ Friend/Colleague     □ Exhibit 
□ Other _________________________________________ 
 
4. Who selected this product? 
□ I did      □ Research Group 
□ University Department     □ Purchasing 
□ Other _________________________________________ 
 
5. Comments/Suggestions:  
______________________________________________________________________ 

 


